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Query Objects 
 
Query objects are the queries (which also has some more information in addition 
to pure queries) that are designed and stored in Intellicus.  These query objects 
are then used to design reports. 
 
 

To get the Query page 
 

 
Figure 1: Query Object page 
 

1. On Intellicus Web Portal, click Repository > Report Objects. 
2. Click Query tab.  Query tab is placed in front. 

 
 

To get a filtered list of Queries 
 
List of queries can be filtered by: 
 
• Starting character (Starts with) 

• Characters that appear anywhere in the query name (Contains) 

 

     
Figure 2: Getting filtered list of queries 
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1. On Query page, check the option on right of  .   
2. To get the right option there, click  and select Start with or Contains. 
3. Specify character(s) in the textbox.   

 
The list will be filtered (not case sensitive) as per the criteria.   
 
 

General steps of designing a new query object 
 
Mandatory steps 
 

1. Specify name and data source (type and connection) related information. 
2. Specify SQL / XML. 
3. Save. 

 
 
Optional activities 
 
• Specify formulas. 

• Set Field properties 

• Look and feel / formatting 

• Field Grouping 

• Hyperlinking 

• Lookup values 

• Mandatory filtering 

 
Details of steps / activities is explained below. 
 
 
To create a copy of an existing query object 
 

 
Figure 3: Creating a copy of an existing query 
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1. On Query page, select the query that you want to copy.  
2. Click the  button.   

 
A query object will be created having contents same as the one that was copied.    
This new query object’s name is prefixed with “Copy of”.  You can select this 
query object and rename it. 
 
 
To design a new SQL based query 
 

 
Figure 4: SQL based query object 
 

1. Click  button. 
2. In Name, specify unique name for this query object.  
3. From Connection, select database connection.  
4. In Datasource Type, select SQL.  
5. Click Edit button to design SQL.  
6. A click on OK will close SQL Editor and the SQL will appear in the SQL 

area.  Fields will appear in Fields area.  
7. Click Save button to save the work.  

 
 

Note: To open SQL Editor in a new window, select Load in New 
Window check box.  If it is not selected, it will appear in the same 
window. 
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To design a new XML based query 
 

 
Figure 5: XML Based query object 
 

1. Click  button. 
2. In Name, specify unique name for this query object. 
3. From Connection, select database connection. 
4. In Datasource Type, select XML. 
5. Click Edit button to get XML Source dialog box and provide required 

information to get XML. 
6. After you click OK on XML Source dialog box, fields will appear in Fields 

area. 
7. Click Save button to save the work. 

 
 

Note: To open XML Source dialog box in a new window, select Load in 
New Window check box.  If it is not selected, it will appear in the same 
window. 

 
 
Access Rights to use a Query Object 
 
After a query object is setup, it is available to all the users (everyone).  You can 
grant or revoke access rights to use a query object. 
 

 
Figure 6: Access rights for a query object 
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To Provide access rights for selected query object, 
 

1. Select the query object and click Access Rights button. 
2. Select organization name to provide rights to all the users within that 

organization. 
3. Select checkbox to provide rights to respective user / role. 
4. Click Set button.  This will save the changes and close the dialog box. 

 
 
Advanced Properties 
 
Properties set here will be applicable to all the reports where this query is used. 
 

 
Figure 7: Advanced Properties on Query page 
 
For description of properties, refer to section Advanced Properties in 
WorkingWithFoldersAndReports.pdf. 
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Fields Attributes (properties) 
 

 
Figure 8: Field Attributes (properties) 
 
• Field: Name of field (as per received from data source). 

• Caption: The text that will appear as caption when this field is selected for 
placement on the report. 

• Width: Number of characters for selected field.  

• Align: To set the alignment for selected field.  

• Hidden: To keep the field not available to be placed on report.  This field will 
also not available for sorting as well as filtering. 

• Data Type: To set data type for field from Date, Character or Number.  This 
is especially useful when field selected is XML type data source and you need 
to set it as number or date.  Similarly when a field that is character (having 
numeric value) is supposed to be used in calculation. 
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To specify input format for a field 
 
When you specify input format for a field, at run time, the application will accept 
data in the format specified. 
 

 
Figure 9: Specifying Data Format for the field. 
 

1. From Fields list, click the field that needs to be accepted in a specific 
format. 

2. Click the ... button on the right of the Input Format entry box.  A dialog 
box opens. 

3. Select the suitable format and provide necessary values for the selected 
format. 

4. Click Ok to accept the changes and close the dialog box.  Characters for 
selected format appears in the Input Format entry box. 

 
 
To specify output format for a field 
 
When you specify output format for a field, values of respective field will appear 
in that format on report. 
 

1. From Fields list, click the field that needs to be accepted in a specific 
format. 

2. Click the ... button on the right of the Output Format entry box.  A 
dialog box opens. 

3. Select the suitable format and provide necessary values for the selected 
format. 

4. Click Ok to accept the changes and close the dialog box.  Characters for 
selected format appears in the Input Format entry box. 
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Fields grouping 
 
When fields in a QO are grouped, they appear within a group header in adhoc 
report wizard.  All the fields of the group can then be selected or removed from 
report with single click.   
 
After creating groups, fields can be assigned to a group.  
 
To create groups, 
 

 
Figure 10: Creating groups 
 

1. In Group Label dropdown box click (Select to add group label) option. 
2. Specify group name.  
3. Repeat steps 1 and 2 to create more groups. 

 
 
To assign a group to fields, 
 

1. From Fields list, select the field. 
2. From Group Label dropdown box, select a group.  

 
Selected field will be part of that group. 
 
 
Formula fields 
 
These are the fields that are not received from database, such as gross salary, 
or grand total.  Formula fields are created and used to handle such need.  They 
are created for report processing.  They cease to exist once report is generated.   
 
Formula fields can be created and embedded in a query object.  A formula field 
may have all the fields as well as formulas existing in the QO. 
 
To create a formula, 
 

1. Click  button to get Formula dialog box. 
2. Set up the formula and click OK to save the formula and close the dialog 

box. 
3. Formula will be listed in Formula list. 

 
Select a formula and click  or  button to shift selected formula up or down.  
A formula lower side in the list can use formula on upper side of the list.  
Opposite should be avoided. 
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Specifying formula 
 
On Formula dialog box, 
 

 
Figure 11: Formula dialog box 
 

1. In Name entry box, specify a name to uniquely identify this formula.  
2. In Return Type, select the type of the value the expression is going to 

return.  
3. In Details box, specify the formula.  (The details are given after these 

steps).  
4. Click OK to save the work and close the dialog box.  

 
The formula is saved and the dialog box is closed. 
 
General syntax for formula is: 
 
FormulaName = formula  (where, FormulaName is the same as specified in the 
Name entry box). 
 
Follow JavaScript Syntax to create a formula.  To create a formula, you can use 
field names and define variables. A formula may have 'if' construct as well as 
'nested if' construct. You can use logical operators too. If want to add more than 
one statements in formula, use semicolon ';' as separator between two 
statements. 
 
Example 
 
• NewForm1 = var a = 5 ; b = 3 ; if (a!=b) { f = a } {NewForm1=f} 

• TotalAmount = var total ; if (unitprice < 10 ) {total = unitprice*quantity} 
else {total = unitprice} {TotalAmount = total} 
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Importing field attributes 
 
You can field attributes for a selected field.  By importing field attributes for a 
selected field, you save time spent in manually setting those attributes.  This is 
done on Import Formatting dialog box.  From one or multiple you can import 
following attributes: 
 
• Caption 

• Width 

• Alignment option 

• Format option 

• Data Type 

• Hidden property 

• Group label 

• Hyperlink 

• Lookup Values 

 
You can select field attribute (to be imported) from a field of any of the saved 
query objects. 
 



 

Working with Query Objects  13 

 
Getting Import Formatting dialog box  
 
On Query Object page, select the right query object and click IMPORT button. 
 
Import Formatting dialog box opens.  
 

 
Figure 12: Import Formatting dialog box 
 
 
Selecting one or more field attributes 
 
Select field attribute from a field from any of the saved query objects. 
 

1. On Import Formatting dialog box, from Query Object dropdown box, 
select a QO.  

2. From Field dropdown box, select the field.  Formats from this field can be 
copied. 

3. Select attributes to import by clicking respective checkboxes. 
 
 
Applying selected attributes to a target field 
 

1. On Import Formatting dialog box, from Target Field, select the target 
field. 

2. Click Apply button. 
 
To apply selected attributes to another target field, repeat these steps. 
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Note: Attributes that can be applied to a target field will depend on data 
type of source field as well as target field.  Lookup values can’t be 
imported if data type of target field is Number.  

 
 

Important: Action of importing attributes can't be revoked.  So, make 
sure you are importing the right attributes before clicking Apply button.    
Click Cancel button to abandon selections made after latest click of 
Apply button and close the dialog box.  Click OK to close the dialog box. 

 
 
Importing attributes from multiple fields 
 

1. On Import Formatting dialog box, from Target Field, select a target 
field. 

2. From Query Object dropdown box, select a QO. 
3. From Field dropdown box, select the field.  Attributes from this field can 

be imported. 
4. Select attributes to import by clicking respective checkboxes. 
5. Click Apply button. 
6. Repeat steps 2 through 5 until you are finished with copying all the 

required attributes. 
7. Click OK to close the dialog box. 

 
 
Mandatory Filtering 
 
Use this feature in case you want your business users apply one or more filters 
while creating and running an adhoc report. By doing this, you are saving 
unnecessary data-transfer that take place from database server. 
 

 
Figure 13: Setting up Mandatory Filters in Query Object 
 
 
Mandatory filtering can be setup in two ways: 
 
• Mandating filtering on any field. User can decide the field to filter on, at 

the time of designing an adhoc report.  

• Mandating filtering on a specific field. User would have to filter on the 
fields specified while designing an adhoc report. 
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To setup mandatory filtering 
 

1. Select (Check) Mandatory Filtering check-box. 
2. To specify a field for mandatory filtering, specify it in On Field dropdown 

box.  If you do not want to specify a field for mandatory filtering now, 
leave it as Any. 

3. Click  button to get another row for mandatory filtering. Repeat step 2.  
 
To remove a mandatory filtering related row, click  button available on the 
right side of that row. 
 
 
Effect of Mandatory Filtering on Adhoc Report Wizard 
 
On Adhoc Report Wizard when a user selects a Query Object (Data source) that 
has Mandatory Filter setup, title of Select Filter Criteria also includes a star. 
 

 
Figure 14: Effect of Mandatory Filtering on Adhoc Report Wizard 
 
In addition to that, if a field was setup while setting up mandatory filter, there 
will be one row for each field (mandatory filter) that was setup.  Its dropdown 
box will be disabled and will have a star mark. 
 
For each mandatory field with “Any” as selected value, Field drop down box will 
be enabled, and will also carry a star mark.   
 
The person working on it has to provide filters for all the rows where star mark 
is present. 
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To specify a hyperlink on a field 
 
When you make a field a clickable hyperlink, you can link a URL or a report with 
that report.  You can make "drill-down" reports using hyperlinked field. 
 
General steps to make a field hyperlink 
 

 
Figure 15: Hyperlink Options dialog box 
 
 

1. Click  button on the right of Hyperlink caption.  Hyperlink Options 
dialog box will open. 

2. Depending on the type of hyperlink needed, specify values for URL or Drill 
Down…  

3. Click Ok. 
 
 
Hyperlink the field to open a specific URL 
 
On Hyperlink Options dialog box,  
 

1. Click URL option button. 
2. In the box provided below URL option button, specify the URL. 
3. In Target, select the way to open the URL. 
4. Click Ok. 
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Hyperlink the field to open a specific report 
 
On Hyperlink Options dialog box, 
 

 
Figure 16: Setting up report parameters in Hyperlink Options dialog box 
 

1. Click Drill down to another report option button. 
2. In Select entry box, select the report that should open when the hyperlink 

is clicked. 
3. Select the most appropriate option for Target.  This is the way report in 

the hyperlink will open. 
4. Specify Report Parameter and the value field if the report needs any 

report parameters to run.  Report Parameter is the parameter in the 
report being set as hyperlink.  Value field is the field within the report that 
will have hyperlink.  Click  to add a row.  Click  to delete respective 
row. 

 
 

Note: A report may have mandatory parameters.  If value of mandatory 
parameters are not specified, the may not get executed. 

 
 
Specify System Parameter(s) and their value(s) to be considered for the report 
being set as hyperlink.  Detail is provided below these steps.  Click  to add a 
row.  Click  to delete respective row. 
 
 

  
Figure 17: Setting up system parameters in Hyperlink Options dialog box 
 
System parameters and their values 
 
• Priority: low, medium, high. 

• Report Format: SYS_REPORT_FORMAT (to use the format of the report from 
where hyperlinked report is run), HTML, ACROBAT PDF, JVISTA, COMMA 
SEPARATED, TEXT, MS EXCEL, XML, INTERACTIVE, MS WORD. 

• Report Connection Name: Select the database using which the report 
should be run. 

• Save File Name: File name to be used if the file is published as implicit 
operation. 
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• Implicit Operation: In addition to view the file, if report needs to be 
published, select Publish. 

• Refresh Data: Select True to run report with latest data.  Select False to run 
report with cached data. 

• Prefetch Drilldown: To start generating hyperlinked report even if user has 
not clicked hyperlink to run the report. 

• Pagination: Select the right option as per need to break pages by Single 
Page (increase page width and length to any size), Multiple Page (divide in 
width, divide in length as per need) and Horizontal Breaks (divide in length 
only, increase width to any size). 

• Show HTMLtoolbar: When viewed in HTML, set Yes to have HTML Toolbar, 
set No for not having toolbar and set Multipage to have toolbar only if report 
is extended to more than one page. 

 
 
Lookup Values for text field 
 
Lookup values are used to set a filter at report design time as well as run time. 
 
Query objects are generally used in adhoc report wizard, the report design tool 
for business users. Lookup values are setup for the fields on which user may 
decide to set filtering at report design time (on adhoc report wizard) or at report 
run time. 
 
On adhoc report wizard, when user sets up a filter on a field, lookup values for 
the field are listed in a dropdown box. User can select a value and proceed 
further with report designing. 
 
Similarly, at run time, a dialog box will appear having the field name and the 
lookup values listed in a dropdown box. The query will be run with the filter 
values specified. 
 
Lookup values can be defined in any of the following ways: 
 
• Predefined: To specify static values. 

• XML: To get values from an xml source. 

• SQL: To get values from values from database using an SQL (used in the 
main query or from a query setup exclusively).  This way you make sure that 
user selects valid options.  

 
Key Field: This is the key field of the table used in main query.  Performance in 
is greatly improved if key field is specified. 
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Predefined Lookup values 
 
To setup predefined lookup values, 
 

 
Figure 18: Setting up Pre-defined lookup values 
 

1. From Fields list, select the field for which lookup values are being setup. 
2. If not checked, check (select) Lookup Values checkbox. 
3. Click Predefined link. 
4. In Display entry box, specify the value that should be presented to the 

user. 
5. In Value entry box, specify the value that should be considered for use, 

when user selects value specified in Display. 
6. Click  button to add the value set in list of lookup values. 

 
Repeat the steps 4, 5, 6 to add all the pre-defined lookup values.  Click Save 
button. 
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SQL for lookup values 
 

 
Figure 19: Specifying User Defined SQL for getting lookup values 
 

1. From Fields list, select the field for which lookup values are being setup.  
2. If not checked, check (select) Lookup Values check box.  
3. Click SQL link.  
4. Check (select) the User Defined SQL checkbox to specify separate SQL 

for getting lookup values from database.  Keeping this check-box 
unchecked (clear) will get distinct values using the SQL defined for the 
main query object. 

5. Check Fetch on Every Use check-box to refresh the list of values at 
query design time, report design time as well as report running time.  
Keeping it clear will fetch values at query design time only. Values will be 
placed in the query object that will be used at report design time and 
report run time.  

6. From Display Column dropdown box, select the column to be used to 
display value to the user (only when SQL is user defined).  

7. From Value Column dropdown box, select the column that will be used in 
filter (only when SQL is user defined).  

8. Click Save button. 
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XML for lookup values 
 

 
Figure 20: Specifying user defined XML for Lookup values 
 

1. From Fields list, select the field for which lookup values are being setup.  
2. If not checked, check (select) Lookup Values check box.  
3. Click XML link.  
4. Check User Defined XML checkbox to specify the XML and select Record 

Pattern.  
5. Check Fetch on Every Use checkbox to refresh the list of values now 

(while setting up QO), report design time as well as report running time.  
Keeping it clear will fetch values now (while setting up QO).  Values will 
be placed in the QO and will be used at report design time and report run 
time.  

6. From Display Column dropdown box, select the column to be used to 
display value to the user (only when XML is user defined).  

7. From Value Column dropdown box, select the column that will be used in 
filter (only when XML is user defined).  

8. Click Save button.  
  
 

Note: In order to include the look up values, you need to select the 
respective checkbox (SQL, XML, Predefined).  At a time, SQL, XML as well 
as Predefined can be included in list of lookup values. Lookup values’ list 
appears in Values box after clicking Save button. 
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Modifying a Query Object 
 
On Query page, 
 

1. Select a query object. 
2. Details of the selected query object appear. 
3. Make changes where required. 
4. Click Save button to make the changes permanent. 

 
 
Deleting a Query Object 
 
On Query page, 
 

 
Figure 21: Deleting a Query Object. 
 

1. Select a query object. 
2. Click  button in that row.  The selected query object is deleted and is 

removed from the list. 
3. Click Save button to make the changes permanent. 
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SQL Editor 
 
SQL Editor is used to create and SQL.  This SQL is used in report and Query 
Object. 
 
 

Note: Date and time when metadata of the selected entity was refreshed 
appears on the top of the SQL Editor. 

 
 
SQL Editor on the left side lists Entities and attributes in the selected entity.  
The area on the right side is divided into multiple tabs: 
 
• Design tab: Use this tab to design relatively simpler queries using drag and 

drop method. 

• Edit: SQL designed on Design Tab is represented as an SQL statement on this 
tab.  You can also write or paste and SQL here. 

• Errors: Errors if any in the SQL statement are displayed on Errors tab. 

• Results: Rows received as a result of SQL execution are displayed here. 

• Sort: To specify sorting preferences. 

• Filters: Set runtime filter criteria on this tab. 

• Procedures: This tab is brought in front when procedure is selected.  Specify 
procedure related details on this tab. 

 
 

Note: Use Sort tab and Filter tab only from Web Studio.  For SQL used 
in a Query Object, users will specify Sort and Filter on Adhoc Wizard. 

 
 
Getting a list of database objects 
 
First line indicates the database connection that will be used to get database 
objects list. 
 

1. Select any of the objects among Table, View, Procedure and Synonym. 
2. Entities available on selected connection are listed.  At a time, the list 

displays a pre-set number of entities. If the entity you are looking for is 
not available in the list, use the drop-down box options to view another 
set of entities. To get next list, click Next link. To get previous list, click 
Prev link. 
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Design Tab 
 
Simple SQL Queries can be designed using Design Tab. 
 

1. Select the source of entities among Table, View, Procedure and 
Synonym.  Entities available are listed in Entities.  

2. Click the entity from the Entity list to get list of attributes of that entity.  
3. Click and drag the attributes to the box under Select.  Value automatically 

appears in From clause. 
 
Repeat the steps 1 through 3 to select attributes from different entities.  
 
 

Note: You can select attributes from multiple entities. 
 
Where 
 
To get a row at the top 
 
Click the '+' in the leftmost cell of column header.  This inserts a row at the top. 
 
To get a row below current row 
 
Click '+' in the row below which you want to add a row for condition.  A row will 
be inserted in the row below the respective row. 
 
To remove a condition 
 
Click 'x' button in respective condition row. 
 
To specify a where clause 
 
• Form a condition by selecting Operand1, Operand2 and Operator. 

• To join conditions, form two conditions and select a relation in rightmost 
column of the first condition (of the two being joined).  

• To group conditions specify opening brace and closing brace in the right row. 

 
 
Group By 
 
In the Group By clause you can provide grouping criteria for the SQL statement.  
To place an entity in Group By, click the entity in the Entity List and drag it in 
the box below Group By. 
 
 
Having 
 
The procedure to complete Having clause is the same as that of Where clause.   
 
 

Note: Do include appropriate summary function in select clause so that it 
can be used in Having clause. 
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Order By 
 
In the Order By clause you can provide sorting (ascending/ descending) criteria 
for the SQL statement.  For a report with grouping, the order by clause must 
have the columns in the same order as of the respective sections in the Layout 
Editor. 
 
 
Edit tab 
 
On Edit tab, you can view and write complex SQL statements that cannot be 
defined using the Design tab.  From Design tab, when you come to Edit tab, the 
SQL in the Design tab is constructed and displayed as a complete SQL 
statement.     
 
You can also write dynamic SQL Queries on Edit tab. 
 
The SQL statement in the Edit tab will be used as the final SQL for compilation. 
 
From Edit tab, if you switch over to Design tab, make changes and get back to 
Edit tab, you will be prompted with a dialog.  This is to prevent a complex query 
(defined in the Edit tab) from being over written when from Edit tab you switch 
over to the Design tab, make some changes, and return to Edit tab. 
 
On that dialog, select Yes to reconstruct SQL designed on Design tab and replace 
existing SQL on Edit tab.  Select No to retain the SQL on Edit tab and use it as 
the final SQL. 
 
 
Dynamic SQL Queries 
 
Using parameters 
 
To include a parameter in the SQL Query, specify a parameter enclosed within 
<% and %>.  
 
Example: To dynamically decide where clause: 
 

SELECT * FROM EmpTbl WHERE <%PrmWhrCls%> 
 
  
Using javascript code block 
 
Use javascript code block enclosed by <@% and %@> to create a dynamic SQL 
Query.  After execution, the code block should return a string that will be 
replaced in the SQL query.  
 
You can use following in the code block:  
 
• if else  

• Parameter value and parameter data type  
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Syntax of Code block 
 

<@% > 

[Executable block, which returns a string] 

<%@>  
 
 
Syntax to use parameter in code block  
 

params("parameterName").getAttribute()  
 
Attributes: "Value" to get value of the parameter and "DataType" to get data 
type of the parameter.  
 
Examples 
 
Example 1. Check if parameter "prmEmpNo" exists. If it does and its value is not 
blank, return the value, else return nothing.  
 

Select * from emp where 1=1 

<@% 

if(params("prmEmpNo") != null &&  

params("prmEmpNo").getValue() != "") 

{ 

return " AND empno in <%prmEmpNo%>"; 

} 

else 

{ 

return ""; 

} 

%@> 
 
 
Example 2. Check if parameter "prmSelectTable" exists. If it doesn't, return 
table name as "emp" else (if it exists) value of the parameter to be used as table 
name.  
 

Select * from  

<@% 

if(params("prmSelectTable") == null) 

{ 

return "emp"; 

else 

return params("prmSelectTable").getValue(); 

} 

%@> 
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Example 3. Construct WHERE clause dynamically (for LOCATIONTYPEID and 
REGNID fields).  
 

select LOCTIONID, LOCTIONNAME,LOCTYPEID,REGNID from 

LOCATIONMASTER where 1=1 

<@% 

var v_Str; 

v_Str = ''; 

var v_Str1; 

var v_Str2; 

var v_Str1=''; 

var v_Str2='';  

 

if(params("prmloctype") != null &&  

params("prmloctype").getValue() != "") 

{ 

 

 

v_Str1 = " AND LOCATIONTYPEID in (<%prmloctype%>)"; 

} 

else 

{ 

v_Str1 = ""; 

}  

 

if(params("prmRegion") != null &&  

params("prmRegion").getValue() != "") 

{ 

v_Str2 = " AND REGNID = <%prmRegion%> "; 

} 

else 

{ 

v_Str2 = ""; 

}  

 

v_Str = v_Str1 +v_Str2; 

return v_Str; 

%@> 
 
 
 
Result 
 
When you select the Result tab, the defined SQL statement will be compiled. 
Record-set will be displayed in case of successful completion.  If there was any 
error, same tab will display the error.  This would help you in finding the exact 
location of error(s), and rectify them. 
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Sort 
 
This tab is used to specify levels of sort at run time.  
 
• Prompt: Select this check box to get sort dialog box at report-run time.  

User will be able to provide sorting options on the dialog box. 

• Qualifier: When SQL is typed in Edit tab, fields may not be prefixed with 
table name and so, Available Fields list also don't have table names prefixed. 
Select a field and specify table name to associate it with a table. This is 
especially useful when you get the same field name from two tables and wish 
to differentiate one from another. 

• Count: Select the number of sort levels to be made available to user.  For 
example you want user to be able to provide three sort choices at run time 
(e.g. by Country, State and county), select 3. 

• Disable Forced Sorting: If due to any reason, result-set received from data-
source is not sorted as per need (like grouping), Intellicus server will sort the 
data.  Check this checkbox to stop Intellicus from doing so. 

 
 

Important: Data sorting performed by Intellicus becomes significantly 
time-intensive process when a record-set has large volume of records.  In 
that case, we recommend not to Prompt and check Disable Forced 
Sorting.  This will make sure Intellicus uses data as it is received from 
data-source. 

 
The fields listed in Available Fields are the fields that will come from database.  
The fields listed in Selected Fields will be available for sorting at run time. 
 
• To move a field from Available Fields list to Selected Fields list, select a 

field from Available Fields list and click > . 

• Click >> to move all the fields to Selected Fields list. 

• To move a field from Selected Fields list to Available Fields list, select a 
field from Selected Fields list and click < .  

• Click << to remove all the fields from Selected Fields list.  

 
Based on the number selected in Count check box, that many dropdown boxes 
will appear on an input form at the run time.  You can select fields that should 
appear by default along with default order (ascending or descending). 
 
In Default Fields select the field, and the sort order.  Click ‘x’ button to delete 
that row.  Pressing enter key in last row will append a row at the bottom.  Select 
a row and Use Up or Down arrow button to modify the sequence of field-
appearance. 
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Filters tab 
 
At report run time, a user may wish to receive the data that makes sense to 
him/her at that time. On this tab, you can set filters so that user can provide 
filter values at report run time. 
  
To add filters 
 
Select a field by clicking it (Press and hold Ctrl key and click fields to select 
multiple fields) to from Available Fields. Click > button to move the fields to 
Selected Fields list.  At report run time, Adhoc tab of Input Parameter Form will 
have 3 rows having all of the selected fields as as dropdown.  Use >> to move 
all the fields to Selected Fields list. 
  
To un-select a field, click the field from Selected Fields list and click < button. 
Click << button to empty Selected Fields list.  
 
• Qualifier: When SQL is typed in Edit tab, fields may not be prefixed with 

table name and so, Available Fields list also don't have table names prefixed. 
Select a field and specify table name to associate it with a table. This is 
especially useful when you get the same field name from two tables and wish 
to differentiate one from another. 

• Max Rows: The maximum number of records to be fetched from the 
database. Number specified here would appear by default on input parameter 
form at run time. User can change it if required at run time.  

• Suppress Duplicates: Check this checkbox to get only one record if record 
has multiple records having completely duplicate values. 

 

 
Figure 22: Filters tab on SQL Editor 
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To setup default value for filter 
 
To get a row at the top 
 
Click the '+' in the leftmost cell of column header.  This inserts a row at the top. 
 
 
To get a row below current row 
 
Click '+' in the row below which you want to add a row for condition.  A row will 
be inserted in the row below the respective row. 
 
 
To remove a condition 
 
Click 'x' button in respective condition row. 
 
 
To setup the value 
 

1. Select the field name from the table. 
2. Specify / select values the selected field from other columns.  Details are 

provided after these steps.  
 
• FieldName: The field name for which default value(s) is being set. 

• Type: Select Adhoc to use the fieldName for accepting the value.  Select 
UserParameter get value using a pre-set user parameter. 

• Data Type: Specify data type of the filter parameter. 

• Parameter: If Type is UserParameter, specify the parameter name. 

• FetchData: Select this check box for the field if filter type is Adhoc and you 
want data should be fetched from the database.  In this case value box for 
this field will appear as a drop-down box. 

• Criteria: Select criteria for the field. 

• Value1, Value2: Based on selected criteria, specify value1 or value1 and 
Value2.  For example, for “Between” as criteria, you need to provide two 
values.  

• Mandatory: Select this checkbox if it is mandatory for user to provide value 
for this field at runtime. 
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Procedure 
 
To set procedure and provide value of parameters if any 
 

1. Click Procedure tab to bring it in front.  
2. Click Procedure from the box listing database object types.  Procedures 

are listed in Entities list.  
3. Double-click an entity (procedure) to select it.  Procedure Name appears 

in Procedure Name area.  Parameters in that procedure appear in Proc 
Parameter list.  

4. For each entry (parameter) in Proc Parameter specify a constant value 
or parameter name. 
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XML Data Source dialog box 
 
Intellicus can get XML data from: 
 
• XML file placed on report server  

• XML File stored on a URL  

• XML column of a database  

 
To setup XML Data source, 
 

 
Figure 23: XML Source dialog box 
 

1. From Source drop-down box, select the source to get XML data.  
2. Depending on option selected for Source, specify required information.  

Details are provided after these steps.  
3. In Record Pattern, select the right option that will get XML fields and 

data for report.  
4. Click OK.  

 
 
Source details 
 
File 
 
Available XML files are listed in Select File box.  Double-click a file to select it.  
Name of selected file appears in File box.  File name can also be typed in File 
box. 
 
 
URL 
 
Specify the URL where XML file is available. 
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Database 
 

1. From Connection, select connection.  
2. In SQL, specify SQL query to get fields.  Click Verify button to verify SQL 

and get record-set.  
3. Specify the column where XML data will be available. 
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